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99

i i5 done le. %;72ﬂﬁd/'ﬂdt “... ﬂ(i/)ﬁ s makes l%ﬁ?/yfj dearer.  ~

7

Why is it called — Emacs?
emacs The name ‘Emacs’ was originally chosen as an abbreviation of
Editor MACroS and was created by Free Software Foundation.

This document includes highlights of some new and existing features and fine points in this customised

version of Emacs 29.1

This customised version based on the GNU Emacs 29.3 (x86_64-w64-mingw32) of
2020-08-21 and Smallworld additions to the Emacs release with GE Smallworld 4.3.

Some screenshots used from Emacs 25.3.1

All comments and suggestions please forward to <igor@hydepark-consulting.com> . You can download this Emacs from
HydePark-Consulting.com/Emacs and view explanations of added features and Emacs useful tips on MagikEmacs.com
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Creating complete directory structure

Creating complete directory structure with few default files (product.def, module.def and load_list.txt) for a

PRODUCT or MODULE using Emacs menu options. See =N

examples for TEST_PRODUCT & test_module directories:

eGNU Emacs 25.3.1 ] -= Wed Oct 4 15:47 0.50 =-

File Edit Options Buffers Tools SW Help

Alias Files

Create PRODUCT Dir.Structure

Create MODULE Dir.Structure

Select Smallworld Environment
Run/Goto Smallworld Session

Start New Smallworld Session
Gis Processes

Class Browser

Class Browser Processes
Shell Processes

List Processes

fos
f2z
C-uf2z

Visual Bookmarks

TEHAe £4d

nent of the GNU operating system.

stroke commands

- Visual Bookmarks provides easily

visible bookmarks, which can be
set/cleared via CTRL-F5 and Toolbar
icon OR simply by clicking on a LEFT
fringe. Navigation between
bookmarks F5-n/F5-p or using the

Toolbar icon. List bookmarks - use

Alt-x ‘bm-show’ (current buffer) and

Alt-x ‘bm-show-all’ (all open buffers).

L__TEST PRODUCT
build.xml
product.def

<- PRODUCT directory structure with files

config

[_ product.def

—magik images <- MODULE directory structure with files
load list.txt

module.def

resources
base
bitmaps
data
n_gb
—messages
source
load list.txt

data
images
L main
libs
modules
L —test module <- MODULE directory structure with files
Ioadﬁlist.txt
module.def
resources
base
bitmaps
data
n_gb
L messages
source
load list.txt

resources
base

bitmaps
data
icons
Java
oc
xamples
1ib

en gb
Ijhe 1p
messages
scripts

source
load_list.txt

File Edit Options Buffers Tools SW Index Magik YASnippet Help

D&Ex|®|&|:‘:gﬁgﬁ@»ﬁ%ﬁz

=|<1/[>| substation. magik

c2 << ¢ e.new(l[jD[}D,D)
<< coordinate.new(10000,10000)

Set Boolmark c4 << coordinate.new(0,10000)
box << sector.new with(cl,c2,c3,c4,cl)
g si.make geometry (:boundary,box)

ok? << _true /

_protection
vﬂew. end_lwt (ok?, true ) Navigate Bookmarks

_endprotect

endmethod

1Y [ E
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Create & Save Frames Layout

- Save Frames Layout — allows to save the current Emacs Frames layout (number of Frames and positions on

a screen) and restore saved Frames configuration on Emacs startup.

eGNU Emacs 25.3.1[] -= Fri Oct 6 13:04 0.77 =-

File Edit Options Buffers Tools SW Help
Alias Files >
Create PRODUCT Dir.Structure
Create MODULE Dir.Structure

Select Smallworld Environment f2s
Run/Goto Smallworld Session f2z
Start New Smallworld Session C-uf2z
Gis Processes >
Class Browser >
Class Browser Processes >
Shell Processes >

List Processes

Tools >
Customise >
Help >
Copying Conditions  Conditions Tor 1
Ordering Manuals Purchasing prir

Tostart... OpenacFile Open Hon
To quit a partially entered command, 1

b wd R H N AC 2 A [L.OC A

TE#Ss 24

(stroke cmmands
Emacs @de Browser
Save Frames Layout
Breadcrumbs list
Command Shell
Imenu

Occur

All

Speedbar
MiniMap Mode

nent off¥he GNU operating system.

A

<f12> b

<f5> <return>
M-z
<S-mouse-2>
M-s o

EXAMPLE: | always use 2(Two) Emacs Frames — 1st Frame split horizontally (Ctrl-x-2) with *gis* buffer

(locked/dedicated mode) and Class Browser, 2nd Frame using for coding. So, | use this feature to save the

Frames Layout and restore on the startup. Use <Alt-f> to switch between frames.

HY I E
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New Use of Scratch Buffer

d

eGNU Emacs 25.3.1[] -= Fri Oct 6 13:26 =-

File Edit Options Buffers Tools SW Help

DeExE% $abRYY2eR Y -EETEHSR

-+ *GNU Emacs*

1st frame;

Welcome to GNU Emacs, one component of t

Emacs Tutorial

Emacs Guided Tour

View Emacs Manual

Learn basic keystroke ¢
Overview of Emacs fea
View the Emacs manu

eGNU Emacs 25.3.1[] -= Fri Oct 6 13:26 =-

File Edit Options Buffers Tools SW Index Magik YASnippet Help
De@x@ s smB Aoyl -EETEHAS 4

ﬁ# This buffer is for Magik code evaluation and for \ A

T

2nd Frame)

*scratch*

«"Text that 1s not saved.
## Use [Magik] Menu OR standard Key Bindings to Tra \
snsmit Method/Region/Buffer.

AN IS

(1,0)

v

(Magik H

«For information about GNU Emacs and the GNU system, \ A

NOTE: another NEW feature - now the *scratch* buffer can be used for Magik code evaluation (see above)

va Development Environment for Emacs

DEE

- The Java Development Environment for Emacs (JDEE) is an add on software package for Emacs that assists

in Java programming. JDEE provides ability editing, compiling, running, debugging, and browsing large Java

programs.

@GNU Emacs 25.3.1 [ d:/Emacs-24.1.1/emacs-23/site-lisp/features/cedet-1.0/semantic/tests/t

@ GNU Emacs 25.3.1 [ d:/Emacs-24.1.1/emacs-23/site-lisp/features/cedet-1.0/semant}

File Edit Options Buffers Tools SV\,{ Cl

lasses JDEE Java Development Jdb |YASnippet

File Edit Options Buffers Tools SW Classes JDEE Java Development Jdb YASnippet Help ] ? 8 x Compile C-cC-vC-c & e
Visit New File... C-x C-f EELEEL: — | B Run App C-cCvCr SljAvacomp,java
Open Recent > #%tesﬂavacomp'java Blass Run Unit Test C-cC-vC-u
Open File... | ] E Debug App C-cC-vC-d
JDEE New 3 Class... } Run Applet C-cC-vC-a
Open Directory... C-xd Interface... b Debug Applet
Insert File... C-xi Console... Build C-cC-vC-b
Close Bean... publi Find >
Save Cx G5 Unit Test... Interpreter >
Save As... C-xC-w EJB 2 0  Documentation >
Revert Buffer Build file.. > P Code Generation >
Recover Crashed Session Other... P Browse >

Check Style
& Project >
Refactor > }
Help > }
J
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Before you can use the JDEE you must tell it where the Java compiler, debugger, and virtual machine are

located on your system. Refer to < "..\emacs293\share\emacs\29.3\site-lisp\features\jdee-2.4.2\Emacs

JDE User's Guide.html"> on how to select and register JDK. Or simply edit these values in the "...\.emacs-

custom":
'(jdee-jdk (quote ("11.0")))

'(jdee-jdk-registry (quote (("11.0" . "C:\\Java\\jdk-11"))))

MiniMap MOde

- MINIMAP mode -
display of the current buffer
on the left side. It highlights
the currently shown region

smaller

and updates its position

automatically. You can
navigate in the minibar by
dragging the active region
with the mouse, which will
scroll the corresponding edit

buffer.

@ GNU Emacs 25.3.1 [ c:/emacs253_64/fras_engine.magik] -= Fri Oct 6 14:04 0.64 =- - a X

File Edit Options Buffers Tools SW Index Magik
Alias Files >
Create PRODUCT Dir.Structure
Create MODULE Dir.Structure

Select Smallworld Environment f2s
Run/Goto Smallworld Session faz
Start New Smallworld Session C-uf2z
Gis Processes >
Class Browser >
Class Browser Processes >
Shell Processes >
List Processes
Tools >
Customise >
Help >
_self.diag( 2 , _se:

', t0 << date time.now() ) )

_for i _route over }
)
B 1 oop

1) .elements ()

_for i cabl:

YASnippet Help
EEHMe ¥ L4

~

iV (RPC) SW410 (Upgrad \

tthod.Retain this metho \

new ()
.size

Emacs Code Browser
Save Frames Layout

Breadcrumbs list <f5> <return>

Command Shell M-z  fewean

Imenu <S-mouse-2>

Occur M-s o =

All

Speedbar b
' MiniMap Mode -

%Dggle display of MiniMap for the current buffer lw

v Global YASnippet mode
‘ Iilnhil Er\nf lack

Two simply useful new features:

- Use Ctrl-Shft-d to duplicate current line of code

- Use Ctr-Alt-Up/Down arrow to move current line or selected block of text Up and Down

Watch MagikEmacs.com for more explanations on custom features of Emacs IDE for GE Smallworld.

HY I E
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Intelligent AutoComplete ( ), which understands classes,

methods(functions) and even <_self> - offering only methods defined on “self” class :

_pragma (classify level=restricted)

_method substatioﬂJget_spatial_context_names()|
##
## Returns sxtra spa
## application defined
##

igl context names to add to the
atial contexts.

»» { :internals }

_endmethod
s
_pragma (classify level )
_method substation|.draw internals (window, my geome®™ry, rwe style, draw flag?)
##
## A draw method whch renders the substation's Mternal world
## within the bounds of its geographic location ge
##

_dynamic lecurrent rendering context!

get spatial context names{(}Ji]
geom get_spatial context

ace qet_spatial_context{) £
an_s_get spatial context names
get spatial context names ()

get spatial context names()
RESTRICTED!

Returns extra spatial context names to add to the

_if get spatial context element for world() f | application defined spatial contexts.
( gsf << rc.geometry set factory ) _isnt unset
_then
display scale name << :auto
an sts << gsf.get style system for( ace name, display scale name )
endif

Custom Toolbar and Tab-bar (use <Ctrl-Tab> to navigate between tabs).

{ GNU Emacs 23.1.1 [ e:fDE\LLIG!mEElods,and,classes.magl'k] -= Sat Jan 30 22:03 -=
File Edit Options Buffers YASnippet Tools SW Custem SW  Magik Help

DEEEBE s YBEBREXBFE D U PAETHAEE x &8 G

= <| > methods_and_classes magikl tﬂ'j

#% text encoding = iso8859 ]
_package sw / mouse-1: switch to buffer "draw_arrow magik"
# Tab-bar mouse-2: pop to buffer, mouse-3: delete other windows

#MagikSF> object.define method target.metadata[:behaviour sinks].p

Custom Toolbar

Save/Restore editing Sessions, which allows you with one click of a button to load multiple files from
a previous closed editing session. Even a cursor positions in the open files will be preserved from the previous

session. . T
Ty eaEEE
Open Saved Session |

HYDFE
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Dynamic Abbreviation - it is a standard function in the Emacs, but, from

my experience, not everybody

knows about. It is allowing you to write just a few characters of words you've written earlier to be able to expand
them. Possible completions searched in the text in the current buffer, and if not found there, in all open buffers.
To expand a word, just put the point right after the word and press <Alt-/>. As soon as you start typing — you are
able to use this feature. Typing the next letter will automatically narrow your possible completions.

# Push it out teo the owning fram o
# re nd t © :
w o respong Lo. # respond to.

self. framework.databus.make_dat e T .

_self.app \ _self.applicationf]
_endmethod endmethod
s = completed

Dynamic Abbreviation with Expansion of Multiple choices

Push it out to the cowning fra

time and you will get multi-choice candidates in a tooltip.

# Push it out to the owning frame
# respond to.
self. framework.databus.make_data

_self.app(ayappide[ﬁxampbs
(s): appear
_endmethod (d): applies

$

— press the same key second

Predictive Abbreviation. it’s fairly similar to Dynamic Abbreviation expansion, which works based on the
contents of the current buffer (or other buffers). Predictive abbreviation expansion works based on the previously
written text. Unlike Dynamic Abbreviation, the text is analysed during idle time, while Emacs is doing nothing
else. As you type you will be offered possible expansion for the word at the left from the cursor position. Typing
new characters will automatically offer different completion. If the correct completion is offered — just press

<Tab> to complete the word.

Light blue colour indicates that there are possible different candidates for the

expansion. To see other candidates — press <Tab> once again and choice of possible completions will be shown. If
the completion is shown in the dark blue colour — that’s mean this is the only possible candidate.

etermine which data types we

. L . s # J
# Determine which data # Determine which data # D =
# should do with the da # should do with the da # should do with the data that is
self.df] I self.dataf] | self.databusdatabus 1
- - data_type name 2
database 3
# Determine which data t
# should do with the dat
self.data |pSysERReEWE |
HY' [
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Automatic insertion of the corresponding ({[ and “. Thus typing *(* will normally insert *()' and

put the cursor between them. Otherwise, when the region is active, it will be wrapped in the parentheses.

use SW->Tools menu to activate/deactivate many useful options.

@ GNU Emacs 25.3.1 [ ¢:/SW43/app_dev_examples/modules/highlight_similar/source/highlight_similar_demo.magik] -= Mo

File Edit Options Buffers Tools SW Index Magik YASnippet Help
Alias Files >
Create PRODUCT Dir.Structure

Create MODULE Dir.Structure

$

Tools >
Customise h >
Help >
T Selr.add _acTIoNn (SW_act]
- B g
te
ic
SE
te
ra
_endmethod
_pragma (classify_level=fISat
## Reacts upon information
## databus.
_method highlight similar p
_if data_type name _is
_if data _isnt _uns

Select Smallworld Environment f2s
Run/Goto Smallworld Session faz
Start New Smallworld Session C-uf2z
Gis Processes >
Class Browser >
Class Browser Processes >
Shell Processes >

List Processes

ETEHeSEd

topic={application_development exeample

(B recordlcelection),

:public )

:map_trail

topic={application_development exeample

Emacs Code Browser

SCOSRSES

Save Frames Layout

Breadcrumbs list

Command Shell

Imenu

Occur

All

Speedbar

MiniMap Mode

Dynamic TODO Mode

Global YASnippet mode

Global Font Lock

Global Highlight Current Line mode
Skeleton Pair mode
Auto-Complete Mode

More Structured Buffers

Minibuffer Incremental Complete mode
Show Trailing Whitespace

.current trail <
Belse
.current trail <
endif
elif data type name it
_if data _isnt _unse

.current rwo_ser << uatdalz]

Highlight Changes Mode: Active
Highlight Changes Mode: Passive
Highlight Changes Mode: Off
HCM: Rotate Faces

HCM: Goto Previous Change
HCM: Goto Next Change

<f12> b

<f5> <return>
M-z
<S-mouse-2>
M-so

<f12> p
<f12>n

| plug

ample

| type

HYDE

i
]}_7)1 November 2024

PARK

Page 11



Highlight text matching PATTERN. examples: In a source code highlight a variable to quickly see all places
it is modified or referenced. New occurrences of that variable will be highlighted as they are typed. In a *gis* or another
buffer that is showing lots of output, highlight the parts of the output you're interested in. Those patterns will be highlighted

as soon as they appear in the buffer. Useful if you have a lot of output during debugging. This option is located on the Edit
menu.

6 GNU Emacs 25.3.1 [ /SW43/app_dev_examples/modules/highlight_similar/source
File Edit Options Buffers Tools SW Index Magik YASnippet Help

Undo Cxu @B FYEETEHa @ EA
Cut C-w
Copy M-w
Paste C-v

ﬂl=m, topic={applicatior
this plugin puts on the d.

Paste from Kill Menu

Clear Igin.define shared constant
Select All C-xh - =
{ :geomet]
search ’ :public )
Replace >
Go To >
Bookmarks > 31 %, topic={applicatior
Fill ctions as provided by the |}
Text Properties >pjilar plugin.init actions ()
Regexp Highlighting > Highlight Regexp... C-xwh
elf. add_abtion Highlight Phrase... Cxwp
Highlight Lines... C-xwl
Highlight Symbol at Point C-xw.
Remove Highlighting... Cxwr [DY
Patterns to Buffer Ccxwb [EY
Patterns from Buffer C-xwi
Taction_messade, :seled

Open Recent Files

- Additional menu item for visiting files that were operated on recently

& GNU Emacs 23.1.1 [ e/DEV_L1G/methods_and_classes.magik] -= Sat Jan 30 22:17 -=

Edit Options Buffers YASnippet Tools SWCustom SW Magik Help

Visit Mew File... C-x C-f k A2 R E A s y 40 ] ZE E E
Open Recent 3 e:/DEV_LIG/Magik/draw_arrow.magik

Open File... e/DEV_LIG/methods_and_classes.magik

Open Directory... C-xd Cleanup list 0 - -
Insert File... Coxi i | pen e/DEV_LIG/methods_and_classes magik |
Close Save list now kel -p

Save CxC-s Optigns...

Qavve Ar Foron o

HY I E

[
U' Page 12
1_1 November 2024

PARK




Snippets for Magik Coding. It allows you to type an abbreviation and automatically expand it into
function templates (similar to electric-magik). Navigation between snippet fields — using <Tab>. Templates will

expand automatically as you type them and they are available via menu too.

_then
>> _true
_else
>> false
_endif
_for Elvalue,tuple) _over <iter invocation>
_loop
_endleoop

= <] [> lexample_framework magik **TEMP** magik
_method example framewor]d . |exa.mple_test_m.ethod ()

##
##
_for i el _over self.fast elements ()
_loop
_if i_el _is _unset
_then
leavel
=l leave ...
endloop
- leave ... with ...
_endmethod

s

Dedicated mode - when a

salmede VX EBEFE 02 EAERAEE xR Y @
ruby-mode »
EHIEDS ' m( a_node, _gather args )
python-mode 3
cperl-mode * bassing ARGS to the network follower
perl-mede 3
nxml-mode v e out for description of ARGS
markdown-made ’ B
magik-mode » definitions N
latex-mode > control structure » block ... endblock block =>
html-mode 4 parent mode 3 catch ... endcatch catch =»
30-mede 3 catch ... throw... endcatch catch =>
css-mode » continue... continue =>
objc-mode v continue... with... continue =>
c-mode 13 elif ... elif =>
c++-mode » finally... finally =>
text-mode v [T finally... with.. [N finally =>
Lood snippets.. how for... over... loop... endloop for=>
Reload allsippets handling... with... handling =>
About if ... end if=>
if ... else ... end ife=>
?;tl testing if .. elif ... else ... end ife=>
then_ leave ... leave =>
_j_f leave ... with ... leave =>
_then lock... endlack lock =>
e loop ... endioop loop =>
L e = over... loop... endloop over=>
1 # @test package... package =>
proc... endproc proc=>
st protect... protection... endprotect protect =>
9TE protect locking... protection... endprotect protect =>
RSt throw... with... throw =>
try... when... endtry try=>
o port.magik 1% of 36k (24,21) (Magik AC Pabbrev HL YAS Abbrev)--—[trace_out(}]-

&M buffer is "dedicated" or locked, Emacs will not select files into that

buffer. Dedicated buffers will have "D" shown in the mode line and marked lock icon. | found it very useful to lock

the *gis* buffer. NOTE: All minor modes are shown in the mode line and you can use the mouse to switch it OFF

or get Help on the specific mode.

(Magik|D] ac [Pabbrev] YAS HL [Abbrev) ——[tracs_cuc(}]-

D
Turn Off minor mode
Help for minor mode
ev YAS HL Abbrev)——

N

HY [
[D]
1_1 November 2024
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Class Browser F3-j / EF3-b - allows you to go back in the File Navigation history, so you are able to
return to the point in a code where you came from during your F3-j key journey.

TEMP.magik by F4-m / F12-m- copy current magik method to the Work (**Temp**.magik) buffer.
Very helpful while making temporary changes in the code or just testing/debugging.

F2-b — to compile message files <*.msg> directly from Emacs.

ECB - Emacs Code Browser which displays a number of informational windows that allow for easy

source code navigation and overview.

|&© GNU Emacs 23.1.1 [ e/DEV_LIG/Magik/SWAF/example_module/source/example_framework.magik] -= Sat Jan 30 22:39 =

File Edit Options Buffers YASnippet Tools

DEEEE «» YRR EXBHEY 28

SWCustom SW Magik ECB Help

DY EEE x X8 4§

=:/DEV_LIG/Magik/SWAF/exampls mod - =<1 methods_and_classes magik draw_arrow magik exal

@4) example framework.magik
¢] example framework.magikc
@] example_plugin.magik

@] example plugin.magikc
@3] load list.txt

m

e_plugin. magik example framewmk,myi@

.current_trayl << _unset e
_endif
_elif data type name _is :recokd selection _then
_if data _isnt unset _a2pdif data[2] _isnt _unset _then
.current_rwo_set X< data[2]

_else
.current_rwo_set <<\rwo_set .new()
_endif
_endif ECB related buttons.
H iy 4 This is handy as we let the databus control our actions.
EW—O = # Think of it as the old note change() methodology.

B config.xml

B draw_arrow.magik

B example_plugin.magik
B gui.xml

>

_self.manage_actions ()

endmethod
B List of currently loaded files.

Bl methods_and classes.magik <« _pragma(classify level=basic)
g - - _method example frameworlf.[r_nanageiactions ()
## ~
## Enable or disable actions as needed.
L4 ##
W-1 History # Expose this action only if we have rwos and a closed trail. L
_self.action(:select_in_ trail) .enabled? << 1
® Exemplars it _if .current_trail _isnt _unset _andif
Shared Constants .current_trail.closed?
new/:.Ln:Lt P -
fublic Mothods - > _true List of all methods/shared m
P ALL Methodst A2 _else — constantsietc.. in the current buffer
init_actiens () } L = P
sw_databus data available( data . -
= = endif
— -
select by trail()
& *Class.Methods* ge“dmetmd
H 2 e fm el v _a_a_ _:_ S
W-2 example_framework.magik -—\-——- example framework.magik 56% of 3.1k (83,0) (Magik AC Pabbrev HL Abbrewv)=-[manage_acticns()]=----Sat]

HY [
[D]
1_1 November 2024
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Integration with an External Editor. This will allow you to load the file from the Emacs, if necessary,
into an external editor of your choice to do some additional editing/searching or other file manipulations.

Use "C:\Emacs293\NP++Magik_Language.XML" to import Magik highlighting into Notepad++

:s\modules\highlight_similar\source\highlight_similar_demo.magik - Notepad++
ng Language Settings Tools Macro Run Plugins Window ?
P¥ 4 @ZAANRRISTEG3T aEEER

LT}
C g ﬁ W 1= highlight_similar_demo.magik

5 - .
iy
5 ## de S.
_method highlight_similar plugin.sw_databus_data_available( data_type_name, ¢
_if data_type_name _is :map_trail _then
_if data _isnt _unset _then
.current_trail << data[2]
_else
.current_trail << _unset
_endif
_elif data_type_name _is :record_selection _then
_if data _isnt _unset _andif data[2] _isnt _unset _then
1 .current_rwo_set << datal[2]
62 _else
.current_rwo_set << rwo_set.new()
- 64 —endif

ment_exeamples}, usa¢

W o
WOrK's

=debug, topic={application_devel

n the fr

1 being available on frar

Magik Smeller, which helps you to find possible problems in the code. A tool to interactively report actual
or possible code syntax problems that are acceptable to the Magik compiler but do not meet development
standards or may be considered inefficient.
A new buffer called *Magik Smeller* will appear showing a list of all possible code "smells", their line
number in the Magik file and a short description. To jump back to a line of code that has been reported
as a smell, place your cursor on that line in the *Magik Smeller* and press "F3-j".

g 4 % EEH=
= <> “Magik Smeller*

Finz; Smell Score: 45
ell per line: 0.381356

A Magik Smell is a piece of code that points to a possible coding problem.
To jump to the code in the original file that a line number is referring to, place your cursor

(5) TEXT ENCODING

a Magik file MUST have a text_encoding declaration as its first line. For example:
#% text_encoding = iso8859_1
Line 1:

(5) PACEKAGE DECLARATION

a Magik file MUST have a _package declaration at the top (usually the second line). For examp
_package sw
Line 1:

—-1\**— #*Magik Smeller* Top of 1.7k (1,0) (Magik Smeller HL Abbrev)--—-Sun Feb 7 21:58-

YT
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Print in colour or black&white directly from the Emacs. Preview in colour — will create an HTML page

with current font locking highlights in the code.

Save As...
Revert Buffer

Recover Crashed Session

& Quick Print (to O5 Default Printer)
Print Buffer
Print Region

CxC-w

E, passing ARGS to the

on

network follower.

of ARGS.

3 &Print with Web Browser
PreBuview with Web Browser

Print with &MNotepad

om

= . €
Postscript Print Buffer Print &Region > &Print with Web Browser

-

Postscript Print Region
Postscript Print Buffer (B+W)
Postscript Print Region (B+W)

Prefuview with Web Browser

Print with &MNotepad

Outline mode for Magik files. Using keys F3+Up/Down in the Outline mode the Magik file can be

collapsed to display only the method names and methods can be unfolded one by one for editing.

SW  Magik ECE OQutline

W XEBFE 2R EDBEEEH

= <] [» methods_and_classes magik Hraw_anow.magik|example_plug|n_mag|k example ﬁ'aﬁ s —=
#% text encoding = isoc8859 1... Toggle Outline Mode |

def slotted exemplar (:example framework,

example framework.define shared constant (
example framework.define shared constant (

:databus consumer data types, ...
:databus_producer_ data types, ...

_method example framework.linit actions () ...

_method example framework.sw databus data available( data_type name, data )
_method example framework.manage actions () .. I

_method example framework .|select_by_trail ()-.--

Show/hide Line numbers in a buffer.

E/source/example_framework.magik] -= Sat Jan 30 22:58 -=

SW  Magik ECE Help

s XBHFw YA ES N Ya g

= <] [> methods_and_classes.magik draw_arrow.magik example_plugin. magik exam &=

86 ##
87
88 #
B89
20
91
92
93
94
95
96
97
98 _endmethod
99 5

1 100

Show Line Numbers |

Q,

Expose this action only if we have rwos and a closed
_self.action(:select_in trail) .enabled? <<

_if .current trail _isnt unset _andif

current trail.closed?
_then
>> true

_else B

>>

_endif

_false

ITI‘

]’jl November 2024
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- Buffer selection- <Ctrl>+<left mouse button> will bring up the floating menu at the cursor position OR use

<Ctrl>+<Tab> to navigate between tabs in the Tab-bar.

= Sat Jan 30 23:02 =

V2B HEERBHAGEE x @ LG

s.magik draw_arrow. magik example_plugin. magi I_<]|examp|e framework_magik

o0 see 1f there is already a trail created. If 5o, notify my
(as it has a diff] SelectBuffer E method
itbus data availabl future trail manipulations.

Mest recently used (11) 3

trail info << se data (:map_trail)) _isnt unset

Changed files (1)

3
example gui.databYEETT0) 3 draw_arrow.magik il info)
Other files (1) r example_framework.magik
Other non-file buffers (5] » . .
. 5 i i example_plugin.magik
_gui.activate () “Files by directory™ i
methods_and_classes.magik

- Save all file backups (*.magik~) in the single configurable directory (system %TEMP% — by default).

Use ‘breadcrumbs’ <F5-Spc> - to set series of Breadcrumb Bookmarks with quick cycling through them

using <F5-Up/Down/Left/Right>.

Visual Bookmarks - use toolbar buttons to Set and Navigate between * @ X —d L

bokmarks
Or simply click on the left fringe to set/remove a bookmark

File Edit Options Buffers Tools SW Index Magik YASnippet Help

DeE*@ s ymBRISPEGRY-EETEREaQ LA
-« create_cycleway1.magik

o Ma (classify level-FINeRl), topic={application_development_
Ekprivate _method create cycleway plugin.init( name, owner, ¢
##

## Initialise slots.

##

_super.init( name, owner, _scatter args )
.geoms << equality geometry set.new()

>> _self

_endmethod
3

Edit/Get Bookmark

ITI‘
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Current Method name in the mode line can be toggled from the [Magik] menu

Heading f2h
Comment Region fa #
Uncomment Region f2 ESC #
Fill Comment f2q
Toggle... td| v Method Name Display s}, usage={internal})
Customise v Electric Magik Mode - foe
Help: Magik Language Reference Enable #Debug Statements <f3>d
Help <f1> ¥ Point at End of Marked Region isnt _unset _andif
Options: ize > 0 _andif
Transmit Method = Move to End nt _unset _andif
® Transmit Method = Do Not Move Poi sed?
Transmit Method = On Repeat, Move tQEnd
>> €
“else -
>> _fals
endif
_endmethod
$
1(Unix)--- highlight similar demo.magik [sw_databus_data available()] 468 0630k (5T
———— e —— ——

| Index| Imenu allowing quickly navigate between methods or use <Ctrl+RightClick>

@ GNU Emacs 25.3.1 [ ¢:/SW43/app_dev_examples/modules/highlight_similar/source/highlight_similar_demo.magik] -= Mon Oct 9
File Edit Options Buffers Tools SW Magik YASnippet Help

[~ WISV W - ORI N O Htmgm",“i&e

&
-E;jl’ highlight_similar_demo.magik
Ler

*Rescan*
Package >

## el e e e

## init_actions() - highlight_similar_plugin.manage_actions()

LI manage_actions() highlight_similar_plugin.select_by_trail() nadt
select_by_trail() highlight_similar_plugin.sw_databus_data_available()
sw_databus_data_available( data_type_name, data) [

TCUrreInT crarkl gaca L2]

Additional highlighting during the incremental search

@ GNU Emacs 25.3.1 [ ¢:/SW43/app_dev_examples/modules/highlight_similar/source/highlight_similar_demo.magik] -= Mon Oct

File Edit Options Buffers Tools SW Index Magik YASnippet Help
DeEExE s vaBRYOPAD - ETEHRS LD
- highlight_similar_demo.magik
_endmethod

$

_pragma (classify_level=m, topic={application development exeamples},
## Reacts upon information being available on the framework's
## databus.
_method highlight similar plugin.sw databus_data available ( data_ type na
_if data_type name _is :mapm _then
_if data _isnt _unset then
.current trail << data[2]

_clge -

.current trail << _unset

HY DE
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le:/DEV_LIG/Magik/SWAF/... &
/example_module/
[ resources
source . . . T . . - .
& sxanpie_framcwork magix Speedbar (F11)-a special skinny frame with a specialized directory listing in

€3 example_plugin.magik

W il methods: Az it. This listing will have both directories and filtered files in it. You can then load
, .gw;‘;;i:?;};;‘;gd;a—“amm files into your Emacs buffer, or expand the files to display all the
| E pubgpltmm methods/progs/constants/.... in them and jump to those tags. You can also expand
B o one multiple directories into your Speedbar frame.

@] example plugin.magike
@3 load list.txt

¢=] load list.txt

=] module.def

€1 description

I

- Use 'Alt-x all <Enter>' or the icon to list\EDIT all lines matching a given regexp in *All* buffer. Changes
made in the *All* buffer is propagated to the original buffer. Use 'F3-j' from *All* —
buffer to go to a match in the original file. Note that changes to the "*All*' buffer © EQG— D% 8l
are propagated back to the original buffer. “out ( 4Show Allmatching .. |zgs )

_endif
_elif data type_name _is :record selection _then
_if data _isnt unset _andif data[2] _isnt wunset _then
.current rwo set new << datal[2]
_else

.current rwo set << rwo_setT
_endif
_endif }wztﬁre}tmgn%m“w bufferchanges are reflected
1 main lilﬁl’
# This is hn‘andy d5 we et the databus contrel cur actiges.
——\**- example framework.magik 52% of 3.1k (65,0)
-ﬁb"!—\llj
Lines matching "current rwo™ in buffer example frampwork.magik.
::urrent_rw-:- set, unset}, # Curgent rwos (as rwo_set}
Jcurrent rw set_newlf( datal[2]
fepibeathiiate set << rwo_set.new()

“i\**—  *All% A1l of 205 (4,44) (A1l HL Abbrev)----Sun Feb

- While you have a file loaded into the
[ Magik Help

Emacs buffer pressing <F12-F12> -
. . DEEBEBE S $BBRE XE
Wlll Open Wlndows Explorer = =1 example framewurk.mggil_{”"*TEMF’**.mag\k

. . . if d i : il hi
in the directory of the current file. S e e

_if data isnt _unset then
.current_trail << data[2]

GNU Emacs 23.1.1 [ e:/DEV_LIG/Magik/SWAF/example_module/source/example_frameworkemagik] -= Sun Feb 7 22:52 -=
File Edit Options Buffers A,

VASnippet  Tools SW Custom

a

— e ] |
() [l « DEV.US » Magik » SWAF » example module v source &+ [43 | [Searcn 2
Wy Organize ~
N Name B Date modified Type Size
00T B i | example framework.magik 1/27/2004 9:17 PM Notepad++ Docu...
Exampleframewurk‘magb( 9/8/2007 9:38 AM MAGIKC File
Folders hd example_plugin.magik 1/30/201011:12 PM  Notepad++ Docu...
| SWAF - example_plugin.magikc 9/8/2007 9:58 AM MAGIKC File
| example_module 5| load_list.bd 1/23/2004 7:03 PM Motepad++ Docu...
resources W
source ~ |« m r
example_framework.magik Date created: 4/19/2009 12:28 PM
| - Notepad++ Document
E Date modified: 1/27/2004 917 PM
Size: 3.13 KB

HY I E
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Magik code folding — where large blocks of code can be distracting. With the code folding feature you can

hide the code not important to your current work. Code folding cleans your workspace. Use <Ctrl-.> key to hide
the block of code while your cursor is inside the desired block.

@ GNU Emacs 23.1.1 [ e/DEV_LI agik/SWAF/example_module/source/example_framework.magik] -= Sat Feb 20 22:50 -=

File Edit Options Buffers YASnippet Tools SW Magik Hide/Show Help

DEEEAs Y aRRISEXEBEFE T ax 99 EEHAL A g4
|= <1 > example ﬁamework.mggil_{]

## Swm:h Hide/Show OFF
# Determine which data types we are interested in and what we

# should do with the data that is passed in.

_if data type name is :map trail then Mode activation button.
+ _if data isnt _unset 7the£|. (&) sos

_elif data type name _is :record segection _then

_if data _isn{ _unset apdif data[2] _isnt _unset _then. (5)...

is is handy as we let e databus control our actions.

gnamethes Indicators of"hidden’ code

- Use <Ctrl-,> key to hide/show code on the ‘method’ level

@ GNU Emacs 25.3.1 [ ¢/SW43/app_dev_examples/modules/highlight_similar/source/highlight_similar_demo.magik] -= Mon Oct 9 12:36 0.42 =-
File Edit Options Buffers Tools SW Index Magik YASnippet Hide/Show Help
De@xals yaBRyvsAaB Y hEEFEFa® LA
- < highlight_similar_demo.magik
_pragma (classify_level=m, topic={application development exeamples}, usage={internal})
## Initialise the actions as provided by the highlight similar plugin
- method highlight similar plugin.init actions (). (9)..._endmethod
$

_pragma (classify_level=, topic={application development exeamples}, usage={internal})

## Reacts upon information being available on the framework's...

- method highlight similar plugin.sw_databus data_available( data type name, data ). (15)..._endmethod
$

_pragma(classify_level=, topic={application development exeamples}, usage={internal})
## Enable or disable actions as appropriate.

- method highlight similar plugin.manage actions () . (10)... endmethod
$
_pragma (classify level= m topic= {igglication development exeamples}, usage={internal})
- method highlight similar plugin. select . by trail()|. (12).. .| endmethod
Q

IYI}
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File Edit Options Buffers YASnippet Tools SWCustom SW Info Help

«an @ildpoEEHA

Up: (dir
(MagikLangRef) Top

Magik Language Reference

Magik Language Reference
The sections in Magik language reference duplicate the information in Using

H H H the Magik language, but the description here is more rigorous and assumes scme
avallable Wlthln Emacs' experience with using the language.

* see Syntactic elements summarises the simplest units of a pregram
such as literals, keywords, operators and simple statements.

see Expressions assignment and invocation describes simple

expressions and alsc the language constructions used for compound
expressions. Assignment and routine invecations are included here as they
are both discrete operations which can themselves be expressions.

* see Compound statements lists all the compound statements of
Smallworld Magik, including blocks, conditionals, loops, statements for
transferring control and statements for handling unexpected events.

* see Defining procedures and methods specifies the syntax for all
possible ways of defining a procedure or method, and includes handling
argument lists and results.

* see Variable declarations gives the five types of variable
declaration with a description of the differences between them, and also
describes constant declarations, variable initialisation, use of packages
and the resolution of free variables.

* see Special characters and keywords lists all the special characters
I and keywords used in Magik, with references to where they are introduced.

*Menu:

* Syntactic elements

* Expressions assignment and invocation

* Compound statements

—-\%%- *info* (MagikLangRef) Top 3% of 1.8k (33,0) (Info HL YAS Abbrev Narro

- Use %USER_EMACS% environment variable in gis_aliases to load your local Emacs settings, like
(setg programmer-tag "User Name, Company Name")
(setq project-name "Project Name")
(setg programmer-time-stamp-format "%:y-%02m-%02d"); %02H:%02M:%02S")
- [Alt-n] to insert-programmer-note;
[Alt-m] to insert-programmer-modified-note;

[Alt-c] to insert-change-note
around selected block — just select the
block of code and press <Alt-c> and respond to.

. _self. framework.databus.make data available (:geometry to highlight,

note change comments will be geom_sat)
placed around the selected code; 4 onp cranee
OR just use this to create a note
change.

START CHANGE
(2010-02-20 Igor Lapitski, Hyde Park)
Push it out to the owning framework databus so that the Application Framework can

Wk W W

[Alt-h] to insert-method-comment;

YT
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I#l%

. B2 % &% =:
Save/Restore Emacs Sessions. That allows you to organize your different ﬁ

projects into "sessions". Each Session has a name (file name). When you 'Save

Session', the list of all opened files is saved into the current session and all the files you were editing will be
reloaded the next time you 'Restore Session'. This allows you to keep different files open in different Emacs
sessions. By using 'Save/Restore Session' you are activating 'Session auto-saving mechanism' - on Emacs exit
current Session will be saved automatically.

- To make prominent marks in '"*gis*' buffer or comments in
'Magik' buffer use '@' at the beginning of the line in '*gis*'

#@ This is the comment that I want to see

buffer and '#@' in 'Magik' buffer. | found this useful when you #6 Review
_if data type name _is :map trail _then

have a lots of output in the *gis* buffer and you need to see TAE Ghim  feme ot ches

.current_trail << datal[2]

specific line — just use this in your code write(“@Important el
info: “, a_variable) and you will be able to see this line in the
output very clearly.

.current trail << _unset

- Use F2-b to send <*.msg> file to running GIS buffer. This will load current *.msg file into an open
currently image.

- Emacs will display highlighting on :enabled?, _false,

) raction message, :select by traill () |)]}
whatever parenthesis matches the one endmethod . _

. . -—\**- example framework.magik 39% of 3.2k (47,72) mhbrev
before or after point. See message in [ matches self.add action(... [-7-]

Mini-buffer describing the match when the matching parenthesis is off-screen. Message contains the line
number.

- Use 'Ctrl-TAB' to switch\cycling between Emacs buffers.

- When using <Ctrl-x/Ctrl-b> to bring up Buffer Selection Menu — use following keys : <c> - to change the

configuration; <s> - to save buffers marked with '*’ ; <d> - to delete buffer

MR Buffer Size Mode File
highlight similar demo.magik 3549 Magik c:/SW43/app dev_examples/mo
% *GNU Emacs* [ 649 Fundamental
*scratch¥* (G key 156 Magik
*% *Messages* 3010 Messages
| *JDEE bsh* 0 Comint
ﬁ 1\%%- *buffer-selection* ILIL eniE S70 (85,0 (Buffer-Selection-Menu HL yas Al

|

],
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List of key—bindingg which might be useful in everyday Emacs operations with Smallworld environment:

<f2>TAB hippie-expand <f3>/ cb-and-clear
<f2> RET magik-transmit-thing <f3>? cb-help
<f2> ESC Prefix Command <f3>b cb-jump-back
<f2># magik-comment-region <f3>c cb-paste-class
<f2> X dev-tools-object-inspector <f3>d toggle-transmit-magik-debug
<f2> | toggle-debug <f3>j cb-jump-to-source
<f2>b magik-transmit-buffer <f3>m cb-paste-method
<f2>e electric-magik-mode <f3> <f3> cb
<f2>g gis
<f2>k sw-reload-dotemacs <fa>c magik-copy-method
<f2>m magik-transmit-method <f4>d dev-tools-debug-method
<f2>q fill-magik-public-comment <f4> e magik-ediff-methods
<f2>r magik-transmit-region <fd>m magik-copy-method-to-buffer
<f2>s gis-version-selection <fd>n magik-set-work-buffer-name
<f2>t add-trace-statement above <fd>o dev-tools-object-inspector
<f3>t addtrace-statement below <fa>r magik-copy-region-to-buffer
<f2> x deep-print variable <fd>s magik-add-debug-statement
<f2>z gis <fd>w magik-compare-methods
<f2> <f1> sw-help-keys <f4> <f4> magik-symbol-complete
<f2> <f7> magik-transmit-method <fd>b bury-buffer
<f2> <f8> magik-transmit-region <fd>g goto-line
<f5>¢g goto-line
<C-S>d duplicate current line <f6> magik-copy-method
<C-M> <up/down> move current line <f7> magik-transmit-method
<f8> magik-transmit-region
<f9> magik-mark-method
BOOKMARKS / BREADCRUMPS <f11> speedbar-get-focus
<C-f5> toggle visual boormark <f12> - ecb-cycle-ecb-buffers
<f5-Spc> set breadcrumb bookmark <f12> = ecb-maximize-window-methods
<f5> <delete> bc-goto-current <f12>b ecb-minor-mode
<f5> <down> bc-local-next <f12>c ecb-toggle-compile-window
<f5> <left> bc-previous <fl2>e send-file-to-external-editor
<f5> <return> bc-list <f12>h ecb-toggle-compile-window
<f5><right>  bc-next <f12> q ecb-redraw-layout
<f5> <up> bc-local-previous <f12>r ecb-restore-window-sizes
<f5>a bm-toggle-cycle-all-buffers <fl2>t ecb-toggle-layout
<f5>d bookmark-delete <f12>u ecb-rebuild-methods-buffer
<f5> e edit-bookmarks <f12>w ecb-toggle-ecb-windows
<f5> | bookmark-load
<f5>n bm-next <M-/> dabbrev-expand
<f5>p bm-previous <M-d> close window
<f5>s bookmark-set <M-b> move cursor to another buffer
<f5>w bookmark-write <M-f> move cursor to another frame
<M-m> insert-modified-note

|

PAREK
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<f12><f12> w32shell-explorer-here <M-n> insert-programmer-note
<f12>m magik-copy-method-to-buffer <M-c> insert-change-note
<f12>n highlight-next-change <M-h> insert-method-comment
<f12>p highlight-previous-change <C-Tab> toggle between files
<fl2>e send-file-to-external-editor

Many of those settings are possible to
customise, use the menu SW->Customose-

>Customise Smallworld Emacs.

The background colour of the custom version

of the Emacs (wheat) also possible to
change. All custom settings will be saved in
the <.emacs-custom> file in your %HOME%
directory. See http://www.hydepark-

consulting.com/Emacs/

Emacs_colours.pdf

for all possible colours.

& GNU Emacs 23.1.1 [] -= Mon Feb 15 00:09 -=
File Edit Options Buffers YASnippet Tools 5W Custom Help

BE® w84

= <] [ *Customize Group: *Customize Group: Misc Custom®
ECB load on Emacs start up?

Pair Mede: , Value Menu| OFF
State|: STANDARD.

Pairing mode on Emacs start up?

Toggle Pabbrev Mode: , Value Mem;ll ON

State|: STANDARD.

E® s 324

= <] > *Customize Group: Smallworld” *Customize Group: Misc Custom*
Operate on all settings in this buffer that are not marked HIDDEN:
Set for current sessionl Save for future sessions'
Undo edits| Reset to saved Erase customizations| Exit|

Parent groups: Emacs
Parent group documentation: Manual.

/- Smallworld group: smallworld Development group
State|: visible group members are all at standard values.

Menu Sw Tools Submenu:
State: HIDDEN, invoke "Show" in the previous line to show.
List of Menu entries for SW->Tocls submenu.

Module Option Save Magikc: , Toggle| on (non-nil)

State|: STANDARD.

If t, save .magikc files when loading module.

Module Option Force Reload: Toqqlel on {(non-nil)

State|: STANDARD.

If t, save .magikc files when loading module.

Resocurces : Group for Smallworld Emacs Message internationalisation.

Aliases : Customise Magik aliases files group.
Magik : Customise Magik Language group. ﬁ

Class Browser : Running Magik Class Browser.

Gis : Running Smallworld GIS.

|§i5c Custom : LIG Custom Emacs User Setting
Product : Customise Magik product.def files group.

—1\**— *Customize Group: Smallworld#* 13% of 1.8k (40,0)

(Custom YAS H

Predictive Abbreviation on Emacs start up?

Toggle Ac Auto Start: | Value Menu Require: 3

State|: SAVED and set.

Non-nil means completion will be started automatically.

>

Initial Frame Width: , 135

State|: STANDARD.

WIDTH of the Initial Frame

Initial Frame Height: , 43

State|: STANDARD.

HEIGHT of the Initial Frame

Custom Background Color: , wheat

State|: STANDARD.

Emacs background color

Custom Modeline Background Color: , wheat3

State|: STANDARD.

Emacs modeline background color

Custom Foreground Color: , black

State|: STANDARD.

Emacs foreground color

Custom Backup Directory: , C:\TEMP

State|: STANDARD.

—1\**- *Customize Group: Misc Custom* 37% of 1.7k (44,45) (C
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There are

several predefined Custom colour Themes for Emacs

eGNU Emacs 25.3.1 [ ¢:/SW43/app_dev_examples/modules/highlight_similar/source/highlight_similar_demo.magik] -= Mon Oci

File Edit Options Buffers Tools SW Index Magik YASnippet Hide/Show Help

v Highlight Active Region FE#R L
~ Highlight Matching Parentheses .
g d endif

Line Wrapping in This Buffer > -

Default Search Options >
v Use CUA Keys (Cut/Paste with C-x/C-c/C-v)
~ Use Directory Names in Buffer Names topic={application development exeamples},
+ Save Place in Files between Sessions yin.select by trail ()
~ Blink Cursor [osed by the current trail belonging
B Enter Debugger on Error be as those seelcted.

Enter Debugger on Quit/C-g

Multilingual Environment >

Show/Hide
Set Default Font...

Save Options

ew ()
' set.all collections() .fast elements ()

L .name)

application.database.rwo set () .select(:col

Manage Emacs Packages tred rwo set.ceometrv set (.current trail.wc

Customize Emacs

> Cuystom Themes
self.databus make data / Tkhooseapre-defined customization theme |

1(Unix)--—- highlight simjlaz

Browse Customization Groups

set ) .
Saved Options trail ()] 78% of 3

-+ *Custom Themes*

Type RET or click to e = -
Type ? to describe theftheme . SpecificOption..

New Options...
le/d 2 mes .

Theme files are namegl *-theme  Specific Face.. d-path’ .
Specific Group...
Note: Your custopf settings ti  AllSettings Matching... phe settings.
To migra your settin(  Options Matching... pere.

Faces Matching...

Available Custom Themes:

s adwaita -— Face colors similar to the default theme of Gnome 3 (Adwait:

s deeper-blue -- Face colors using a deep blue background.

o dichromacy —-- Face colors suitable for red/green color-blind users.

s leuven —- Face colors with a light background.

s light-blue —- Face colors utilizing a light blue background.

8 manoj—-dark —- Very high contrast faces with a black background.

s misterioso —-- Predominantly blue/cyan faces on a dark cyan background.

s tango-dark —- Face colors using the Tango palette (dark background).

m tancon —— Fare cnolore neina the Tanman nalette (Ticght haclkoaronnd)

1\%*— *Custom Themes* Top of 1.3k (1,0) [ (Themes HL yas Abbrev)
HYDE
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Use them based on your own taste:

@ GNU Emacs 25.3.1 [ ¢:/SW43/app_dev_examples/modules/highlight_similar/source/highlight_similar_demo.magik] -= Mon Oct 9 13:14 0.38 =-

File Edit Options Buffers Tools SW Index Magik YASnippet Hide/Show Help
CecExa $BEBrysyPaeRY-EETEHE A

-+ highlight_similar_demo.magik

unset

data type name 1is :record selection
andif data[2] _isnt unset

~

data |2

data isnt wunse

< rwo set.

_self.

cl <Sify_level=m, topic={application development exeamples)!, usage={internal

method highlight similar plugin.
_Selit. :filter to trail) .enabled? << _
isnt unset andif

.closed?

@ GNU Emacs 25.3.1 [ c:/SW43/app_dev_examples/modules/highlight_similar/source/highlight_similar_demo.magik] -= Mon Oct 9 13:19 0.64 =-

File Edit Options Buffers Tools SW Index Magik YASnippet Hide/Show Help
BIRyJTEeEFEETRHAs S L4

DeExE 9 &
=< highlight_similar_demo.magik

_else
.current_rwo_set << rwo_set.new ()

endif
_endif

self.manage actions ()
_endﬁéthod -
$
_pragma(classify_levelz:EEEE, topic={application_development exeamples}, usage={internal})
## Enable or disable actions as appropriate.
_method highlight similar plugin.manage actions ()

if

_self.action(:filter to_trail) .enabled? << current rwo_set _isnt _unset _andif

.current_rwo_set.size > 0 _andif
current trail _isnt _unset _andif

.current trail.closed?

_then
>> true
_else -
>> false
_endif -

éFndmethod

HYD
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Key bindings for Magik mode

Several of these commands interact with a Smallworld session. If there is a current Gis buffer, or only one Gis
buffer, then the corresponding Smallworld session is used; otherwise, you are prompted for the required Gis
buffer.

Commands which provide an interface to the Development Tools application are only applicable when this
application is available in the relevant Smallworld session. The application is loaded and started if necessary; any
errors are reported to the relevant Gis buffer.

F2,B Transmit the buffer to a Smallworld session.

F2,Ror Transmit the current region to a Smallworld session.

F2, F8 or F8

F2, M or Transmit the method which contains the cursor position to a

F2, F7 or F7 Smallworld session.

F2, Enter Transmit the top-level Magik language construction surrounding the point in the current buffer, such as a
method or procedure definition, to a Smallworld session.

F2,$ Transmit the chunk of Magik code, delimited by $ lines, and containing the cursor position, to a Smallworld
session.

F4, F4 For a running Smallworld session, finds the symbol that starts with the current word, or lists all the available
completions.

F4, O or Inspect a Magik object. Prompts for an expression which is

F2, Shift+X evaluated within a Smallworld session to return the object to

F2, X inspect; the word at the cursor position is available as a default.

F4, O and F2, Shift+X  display the object in an Object Inspector from the Development Tools application.

F2, X displays the object in an Emacs Deep Print buffer.

F4, D Send a method to a Magik Debugger from the Development Tools application in a Smallworld session.

F2, Spacebar Insert the Magik template for the preceding text

F2, # Add a leading # to each line in the region to convert them to comments.

F2, Esc, # Remove a leading # from each line in the region.

F2,Q Fill comment line. Formats the current line into separate comment lines, adding leading indentation and # or
## to match the initial line.

F2,H Format the current line as a comment heading.

F2, T Add a trace statement above current line. When executed, the text of the current line is output.

F3, T Add a trace statement below current line. When executed, the text of the current line is output.

F4,S Add a Debug statement; a toggle is available so that Debug statements can be transmitted as comments or
as executable commands.

F4, R Copy the current region to a work buffer.

F4, M Copy the current method to a work buffer.

F4, N Open a work buffer and give it a name.

Ctrl+M+H or F9 Mark the current method.
F4, Cor F6 Copy the current method.

F4, W Compare methods using standard Emacs facilities.
F4, E interfaces to the Emacs command compare-windows.
HY' [
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Key bindings for other modes

Some key bindings are available for the other Smallworld major modes.

Aliases mode
Ctrl+C Run command definition. In the Aliases buffer, finds the command definition which contains the cursor
position and uses the launcher program to run it; otherwise prompts for the required definition.

Environment mode
A buffer in Environment mode is readonly so alphanumeric keys are used as shortcuts for commands.
Enter Select the Smallworld Core product indicated by the cursor middle-clickposition; this product installation
defines the environment for any new Smallworld sessions.
Spacebar Move the cursor to the next product installation in the buffer.

R Run the Gis command in the environment defined by the cursor position. Does not change the environment
for any other sessions.

+ Add a new product installation; prompts for the Smallworld Core product location, and a name and version
for the installation. Only available if a version file is in use.

Q Quit; closes the buffer without making any change to the environment.

Loadlist mode

F2,B Transmit buffer. Uses the load list to load Magik files into a current Smallworld session; prompts for the
required Gis process if there is more than one.

F2,C Toggle to control whether compiled Magikc files are saved.

Ctrl+C, R Refresh buffer. Uses the current contents of the directory containing the load list file to update the contents

of the buffer. You can change the order of entries and save a new load list file if required.

Message mode
F2,B Transmit buffer. Compiles the buffer contents and loads into a current Smallworld session; prompts for the
required Gis process if there is more than one.
F2,C Compile message file. Compiles the buffer contents ready for loading, but does not load it.
F2, Up Arrow Move the cursor to the previous or next message.
F2, Down Arrow
F2, M Mark message.

Module mode

F2,B Transmit buffer. Uses the buffer contents to load all module source files and all compiled message files into
a current Smallworld session; prompts for the required Gis process if there is more than one.

F2, D Reload module definition. Loads the buffer contents into a current Smallworld session; does not load
module source files or resources.

F2,C Compile message files. Compiles all message files for the module ready for loading.

F2, Shift+R Remove module definition from a current Smallworld session. This is sometimes required to ensure the
correct functionality is included in the session.

F2,S Toggle the option to save compiled Magikc files when loading module source files.
F2,R Toggle the option to force reloading of a module which is already loaded.
HY' [
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Product mode

F2,B Transmit buffer. Uses the buffer contents to add the product to a current Smallworld session; prompts for
the required Gis process if there is more than one.
F2,R Reinitialise product. Uses the buffer contents to redefine the product in a current Smallworld session where

the product is already defined.
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